
 
 

AbsoluteIDQ® Kit 
 

User Manual p400 HR 

 UM-p400-HR-Thermo-3 
Last modified on 3/13/2018 12:23 PM For Research Use Only. Not for use in diagnostic procedures. 



Page 2 Table of Contents 
 

AbsoluteIDQ® p400 HR Kit for Thermo Scientific™ Q Exactive™ 

AbsoluteIDQ® p400 HR Kit Table of Contents 
 
AbsoluteIDQ® p400 HR Kit Table of Contents ................................................................ 2 

Symbols ............................................................................................................................... 6 

1 About the Kit ................................................................................................................ 9 
1.1 AbsoluteIDQ® p400 HR Kit Contents .................................................................................... 12 
1.2 Workflow at a glance ............................................................................................................. 15 

2 Required Equipment and Materials (Not Supplied) ................................................. 17 
2.1 Mass Spectrometer and Laboratory Equipment ................................................................... 17 
2.2 Chemicals and Solvents ........................................................................................................ 19 
2.3 Software ................................................................................................................................ 19 

3 Safety Instructions ..................................................................................................... 21 
3.1 Safety Instruction for Personnel Protection ........................................................................... 21 
3.2 Proper Disposal of Laboratory Waste ................................................................................... 21 

4 Instrumental Setup .................................................................................................... 23 
4.1 Acquisition Methods and Tune Files ..................................................................................... 23 
4.2 Quantitation Methods ............................................................................................................ 24 
4.3 Create Tune Files .................................................................................................................. 25 
4.4 Create Acquisition Methods .................................................................................................. 26 
4.5 Link Tune Files to Acquisition Methods ................................................................................ 27 
4.6 Autosampler and pump settings in the acquisition methods ................................................. 31 
4.7 UHPLC System ..................................................................................................................... 33 

5 Preparing Solvents .................................................................................................... 35 
5.1 Preparing Mobile Phases and Solvents ................................................................................ 35 
5.2 LC Part – Solvent A and B .................................................................................................... 35 
5.3 FIA Part – FIA Solvent .......................................................................................................... 36 



Table of Contents Page 3 
 

 

5.4 Autosampler Wash Solvents ................................................................................................. 37 

6 System Suitability Test (SST) and Instrument Calibration ...................................... 39 
6.1 Cleaning of LC-MS/MS System ............................................................................................ 39 
6.2 Prepare Blank and Testmix ................................................................................................... 40 
6.3 Mass Calibration of the Q Exactive™ ................................................................................... 41 

6.3.1 Calibration Solution for Customized Mass Calibration .................................................. 41 
6.3.2 Instrument Calibration ................................................................................................... 42 

6.4 Conditioning the UHPLC Column.......................................................................................... 47 
6.5 Perform the System Suitability Test ...................................................................................... 47 

6.5.1 SST – LC part ................................................................................................................ 48 
6.5.2 SST – FIA part ............................................................................................................... 55 

7 Kit Preparation ........................................................................................................... 61 
7.1 Overview Kit Workflow .......................................................................................................... 62 
7.2 Overview Lab Workflow ........................................................................................................ 63 
7.3 Prepare Kit Components and Samples ................................................................................. 64 

7.3.1 Phosphate Buffered Saline (PBS) ................................................................................. 64 
7.3.2 Internal Standard Mix (ISTD) ........................................................................................ 64 
7.3.3 Calibration Standards (Cal1 – Cal7) ............................................................................. 65 
7.3.4 Quality Control Samples (QC1 – QC3) ......................................................................... 65 
7.3.5 Plasma Samples ........................................................................................................... 65 

7.4 Preparing Solvents and Reagents ........................................................................................ 66 
7.4.1 Pre-Mix for Derivatization .............................................................................................. 66 
7.4.2 Phenylisothiocyanate (PITC) Derivatization Solution .................................................... 66 
7.4.3 Extraction Solvent ......................................................................................................... 66 
7.4.4 Mobile Phases ............................................................................................................... 67 
7.4.5 Register the Kit Plate in MetIDQ ................................................................................... 68 
7.4.6 Prepare the Kit Plate ..................................................................................................... 70 

8 Processing the Kit Plate with the Mass Spectrometer ............................................ 75 
8.1 LC part ................................................................................................................................... 75 



Page 4 Table of Contents 
 

AbsoluteIDQ® p400 HR Kit for Thermo Scientific™ Q Exactive™ 

8.2 FIA part .................................................................................................................................. 78 

9 Data Processing – LC Part ........................................................................................ 81 
9.1 Quantitation Method .............................................................................................................. 81 
9.2 Adjust Retention Times ......................................................................................................... 82 
9.3 Quantitation Procedure ......................................................................................................... 87 

10 Appendix .................................................................................................................... 93 
10.1 Pump Settings ....................................................................................................................... 93 
10.2 Autosampler and Column Oven settings .............................................................................. 95 

10.2.1 Thermo Vanquish™ ...................................................................................................... 95 
10.2.2 Thermo UltiMate™ 3000 RS ......................................................................................... 99 
10.2.3 Injection Volume .......................................................................................................... 100 

10.3 MS Settings and Tune Files ................................................................................................ 101 
10.4 Abbreviations....................................................................................................................... 111 
Ordering and Technical Support ..................................................................................................... 112 

 



AbsoluteIDQ® p400 HR Kit Page 5 
 

 

The information in this manual is subject to change without notice and should not be con-
strued as a commitment by BIOCRATES® Life Sciences AG to assume responsibility for any 
errors that may appear. This manual is believed to be accurate for preparing the Abso-
luteIDQ® p400 HR Kit and for using the MetIDQ™ Software. The AbsoluteIDQ® p400 HR 
Kit is for research use only and not for use in diagnostic procedures. While every pre-
caution has been taken in the preparation of this manual, BIOCRATES® Life Sciences AG 
shall not be liable for punitive, incidental, or consequential damage in connection with or 
arising from the use of this manual. 
AbsoluteIDQ® and MetIDQ™ are trademarks of BIOCRATES® Life Sciences AG. All other 
trademarks are the sole property of their respective owners. It is not intended to encourage 
use of these products in any manner that might infringe on the intellectual property rights of 
others. 
Copyright © BIOCRATES® Life Sciences AG 2017. All rights reserved. BIOCRATES® is a reg-
istered trademark of BIOCRATES® Life Sciences AG. Procedures, methods, and components 
of the AbsoluteIDQ® Kit and the MetIDQ™ Software are patent-pending. For brevity, MetIDQ 
may be used in place of the full product name MetIDQ™ and Kit may be used in place of the 
full product name AbsoluteIDQ® p400 HR Kit in descriptions and tables in this manual. 
 
For Research Only. Not for use in diagnostic procedures. 
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Symbols 
Symbol Description 
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1 About the Kit 

AbsoluteIDQ® p400 HR Kit 
 
The AbsoluteIDQ® p400 HR Kit is based on a combination of several experimental steps. 
Therefore, it is required to read this user manual in detail before proceeding with the 
analysis of the kit. If you need support, please find the contact details on the last page of this 
manual. Here you also find links to our video tutorials and FAQ system. 
The AbsoluteIDQ® p400 HR Kit has been validated with a Thermo Scientific™ Q Exactive™ 
Focus mass spectrometer coupled to a Thermo Scientific™ Vanquish™ UHPLC system. 
Other Q Exactive™ platforms were also tested and can be used with the Kit (see section 
2.1). 
The Kit combines a flow injection analysis (FIA) and a liquid chromatography (LC) method. 
The Kit can be used for a variety of application areas, such as biomarker discovery, disease 
phenotyping, clinical research, pharmaceutical R&D, nutritional or functional food analysis, 
or to study environmental effects. The assay quantifies up to 408 metabolites from eleven 
compound classes: 
 

• amino acids 
• biogenic amines 
• monosaccharides (hexose) 
• acylcarnitines 
• diglycerides 
• triglycerides 

• lysophosphatidylcholines 
• phosphatidylcholines 
• sphingomyelins 
• ceramides 
• cholesteryl esters 

 

A list of metabolites and details on the analytical performance can be found in the Analytical 
Specifications document (“AS-p400-HR-#.pdf” on the USB stick). The data acquisition is 
performed using full MS scan mode and PRM mode for isoleucine. For quantitation, calibra-
tion standards in seven concentration levels and stable isotope-labeled internal standards 
(ISTD) are used. The internal standards are partially integrated in the filters of the Kit plate. 

https://www.youtube.com/channel/UCps9fJHFhaU1-KCej8h24_w
https://support.biocrates.com/tiki-index.php
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The analytical performance is validated using quality controls (QCs) at three concentration 
levels. The Biocrates® proprietary MetIDQ™ software is an integral part of the Kit and must 
be installed before starting with the Kit preparation. Please refer to the MetIDQ™ manual 
(“UM-MetIDQ-Carbon-#.pdf” on the USB stick). 
The AbsoluteIDQ® p400 HR Kit was validated with human EDTA plasma. Both EDTA and 
heparin are suitable anticoagulants. Due to its biological similarity, human serum can also be 
used without impairing the analytical performance. For other biological matrices and species, 
please refer to our provided application notes (USB stick and http://www.biocrates.com). On 
Biocrates’ homepage guidelines for the collection and preparation of biological samples are 
provided (“Sample Preparation Guidelines”). 
Up to 82 samples can be analyzed with a full 96-well Kit depending on the number of quality 
controls (QCs), see info box below. The remaining wells are reserved for one blank, three 
zero samples, seven calibration standards, and three QCs. The required laboratory equip-
ment is listed in section 2: Required Equipment and Materials (Not Supplied). 
 

 

 

We recommend analyzing QC level 1 or 2 in replicates of 4 or 5. This guarantees a 
higher quality of analytical performance when normalizing data within a single plate 
or across several plates (see Appendix “Data Normalization“ in the MetIDQ user 
manual). We also recommend reviewing the EMEA guidelines on bioanalytical 
method validation (European Medicines Agency, 2011). 
 

  

http://www.biocrates.com/
http://www.biocrates.com/services/metabolomics-services
http://www.ema.europa.eu/ema/index.jsp?curl=pages/includes/document/document_detail.jsp?webContentId=WC500109686%26mid=WC0b01ac058009a3dc
http://www.ema.europa.eu/ema/index.jsp?curl=pages/includes/document/document_detail.jsp?webContentId=WC500109686%26mid=WC0b01ac058009a3dc
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Shipping and Storage Information 
 

After receiving an AbsoluteIDQ® p400 HR Kit: 
 

1. Open the Kit box and store the vial box and the Kit plate (sealed in a plastic bag) be-
low -18 °C until use. 
 

2. Store all other contents of the Kit box at room temperature. 
 

3. Keep the Kit plate sealed until use. Mind the expiration date on the Kit plate and vial 
box. 

 

  

 

The AbsoluteIDQ® Kit is shipped in one package, except dry ice shipments (op-
tionally). Keep the AbsoluteIDQ® Kit plate in the plastic bag sealed under nitro-
gen until use. Biocrates® can only guarantees a proper Kit performance if the 
plate is stored unopened in its original plastic bag and away from light. Vial box 
and Kit plate must be stored below -18 °C. All other items can be stored at room 
temperature. Please find the expiration date on your Kit box. Storage at -80 °C 
extends the shelf life for additional six month. 
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1.1 AbsoluteIDQ® p400 HR Kit Contents 
 

Kit Item Description Details 

AbsoluteIDQ® p400 HR Kit plate, 
1 item, store below -18 °C! 

Plate stack consisting of a filter 
plate and a capture plate that 
are attached with tapes 

Sealed under nitrogen in a plas-
tic bag. Do not open until start-
ing kit preparation. 

96-deep-well plate, 
1 item Empty capture plate Used to dilute the extracts after 

Kit preparation. 

Silicone mats, 
2 items 

Silicone coverings for 96-well 
plates 

Used to seal the plate after 
preparation. 

Biocrates FIA Mobile Phase 
Additive, 2 items (1 spare) Sealed glass ampules 

Component for preparing FIA 
Solvent. Non-hazardous mix-
ture. 

Tube for derivatization solution, 
1 item Empty plastic tube Used to prepare derivatization 

solution. 
   
Vial Box: store below -18 °C! 

Testmix LC, 1 glass vial 
(2 vials in 24-well starter kit) 

Biocrates Testmix for LC part 
(dried) 

Standards used for LC system 
suitability test. 

Testmix FIA, 1 plastic vial 
(2 vials in 24-well starter kit) 

Biocrates Testmix for FIA part 
(dried), purple cap 

Standards used for FIA system 
suitability test. 

p400 HR QC, 3 plastic vials 

Biocrates Quality Controls (ly-
ophilized plasma): 
QC1 (green cap), QC2 (blue 
cap), QC3 (yellow cap) 

Spiked human plasma in 
different 
concentration levels. 

p400 HR Cal, 7 plastic vials Biocrates Calibration Standards 
(lyophilized), red caps 

Calibration standards used for 
the LC-MS quantification. 

p400 HR ISTD, 1 plastic vial Biocrates Internal Standard Mix 
(lyophilized), orange cap 

Additional internal standards for 
Kit plate. 
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Kit Item Description Details 

USB memory stick (one USB stick per delivery): 

MetIDQ™ Software  Version Carbon Kit workflow manager. 

OracleXE (Express Edition) 
Database 32-bit and 64-bit versions Database for MetIDQ™ Soft-

ware. 

User Manual and 
Quick Start Guide 

UM-p400-HR-Thermo-#.pdf 
Quick Start Guide-p400-HR-
Thermo-#.pdf 

Read carefully before using the 
Kit.  

User manuals for MetIDQ™ 
software and modules 

UM-MetIDQ-Carbon-#.pdf 
UM-StPk-#.pdf 

Read carefully before using the 
Kit.  

Analytical Specifications AS-p400-HR-#.pdf Read carefully before using the 
Kit.  

Application Notes pdf documents Kit application with different 
sample material and species. 

SOPs pdf documents Protocols for the analysis of 
different matrices. 

Guidelines for sample collection pdf documents Guidelines for collecting plas-
ma, serum and tissue samples. 

Quantitation Methods Xcalibur™ quantitation methods Methods for data processing. 

 
Instrument specific Files on USB stick 

Kit Item Details 

Quantitation methods 
for Xcalibur ™ 4.0 

Q Exactive™ Focus 
KIT2-LC1_XcaliburQuan_1011.pmd 
KIT2-LC2_XcaliburQuan_1012.pmd 

Q Exactive™ 
KIT2-LC1_XcaliburQuan_1111.pmd 
KIT2-LC2_XcaliburQuan_1112.pmd 

Q Exactive™ Plus 
KIT2-LC1_XcaliburQuan_1211.pmd 
KIT2-LC2_XcaliburQuan_1212.pmd 

Q Exactive™ HF KIT2-LC1_XcaliburQuan_1311.pmd 
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1.2 Workflow at a glance 
 

 
 

Check the LC-MS performance before you start with the Kit preparation. Note that the time 
designations are approximate. 

LC-MS setup
(1-2 hours)

• calibrate Q Exactive™
• prepare mobile phases, testmix, wash solvents, install and condition UHPLC column
• load and setup acquisition methods
• run SST for LC-MS, evaluate system performance, and troubleshoot if necessary

sample  
preparation

(4 hours)

• generate plate layout and worklist in MetIDQ™
• prepare ISTD, calibration standards, QCs, and thaw samples
• pipette ISTD, blank, zero, calibration standards, QCs, samples according to plate layout
• perform derivatization, extraction, and extract dilution

LC + FIA runs
(32 hours)

• import sequences (worklist) into Xcalibur™
• run LC-MS analyses (2 injections per sample)
• setup LC-MS system for FIA analysis
• run SST for FIA, evaluate and troubleshoot if necessary
• run FIA-MS analyses (2 injections per sample)

data processing
(2 hours)

• check quantitation methods and quantify LC-MS data with Xcalibur™ QuanBrowser
• export results (Excel file)
• import LC-MS results file into MetIDQ™
• import FIA-MS data into MetIDQ™
• perform statistical Analysis in MetIDQ™(optional)
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2 Required Equipment and Materials (Not Supplied) 
Instrumentation, laboratory equipment, chemicals, and solvents listed below are required to 
use the AbsoluteIDQ® p400 HR Kit and are not provided with the AbsoluteIDQ® p400 HR Kit. 

2.1 Mass Spectrometer and Laboratory Equipment 
Material/Instrument Specifications 

Mass Spectrometer 

• Thermo Scientific™ Q Exactive™ Focus 
• Thermo Scientific™ Q Exactive™ 
• Thermo Scientific™ Q Exactive™ Plus 
• Thermo Scientific™ Q Exactive™ HF 
 

Ion source: HESI-II 
 

UHPLC System 

• Thermo Scientific™ Vanquish™ UHPLC binary pump 
• Thermo Scientific™ UltiMate™ 3000 RSLC integrated system (with 10 

µL inline filter instead of standard 150 µL mixer) 
 

Injection volumes: 5 µL and 20 µL 
 

Autosampler Sample manager for 1 mL deep-well plates, cooled (10 °C) 

Column Oven Column oven, 50 °C 

UHPLC Column 
UHPLC column for AbsoluteIDQ® p400 HR Kit, 
available only from Biocrates® 

UHPLC Pre-Column 
Phenomenex® SecurityGuard™ ULTRA Cartridge C18/XB-C18 for 
2.1 mm ID column (Phenomenex® ordering no. AJ0-8782), 
also available from Biocrates® 

UHPLC Pre-Column 
holder 

Phenomenex® SecurityGuard™ ULTRA Holder (Phenomenex® ordering 
no. AJ0-9000), 
also available from Biocrates® 
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Material/Instrument Specifications 

Nitrogen evaporator or 
pressure manifold 

Nitrogen evaporator for 96 well 
plates, 
vendors e.g. Techne, Porvair, VLM 
or Organomation 

Positive Pressure Manifold for 96 
well plates, 
e.g. Waters® Positive Pressure-96 
Processor or 
Biotage® PRESSURE+ 96 Manifold 

Note: the evaporator or pressure manifold must be located in a fume 
hood. If a pressure manifold is used, a plate centrifuge is not required. 

Centrifuge 
Must be able to centrifuge 96-well 
plates of 5 cm height at 500 x g 

Not required when a pressure mani-
fold is used 

Nitrogen supply Minimum pressure requirement of 4 bar 

Solvent bottles From 50 to 1000 mL 

Balance Accuracy < 1 mg 

Plate shaker e.g. Eppendorf® ThermoMixer® or MixMate® 

Vortexer Any model 

Pipettes 

• Single channel: volume range from 10 μL to 1000 μL 
• Repeater: using 1.0, 2.5, and 10 mL tips (important for reproducibility), 

e.g. Eppendorf® Multipette® E3 (Ordering No. 4987000010 or 
4987000371) 

• 8-channel: volume range from 50 μL to 1200 μL, 
e.g. Eppendorf® Xplorer® plus (Ordering No. 4861000821) 
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2.2 Chemicals and Solvents 
Solvents/Chemicals Specifications 

Ethanol, methanol, acetonitrile, 
water, and isopropanol LC-MS grade 

Formic acid LC-MS grade 

Phenylisothiocyanate (PITC) sequencing grade (for example Sigma Aldrich 317861) 

Pyridine p.a. grade or higher 

Ammonium acetate LC-MS grade 

Phosphate buffered saline (PBS) p.a. grade (for example Sigma Aldrich P4417) 

2.3 Software 
Software Required version Details 

Thermo Xcalibur™ Version 4.0 MS data acquisition and quantitation 

Microsoft® Excel® Version 2007 or later Export of Xcalibur™ quantitation 
results for MetIDQ™ 

Oracle® database 

Option 1 (recommended): 
Full commercial version 
Option 2: 
Oracle XE, free of charge, provided 
with Kit USB stick. No support and 
updates provided by Oracle®. 

Required for MetIDQ™ 

Biocrates® MetIDQ™ Provided by Biocrates® 
Sample registration, Kit validation, 
data exportation, and statistical anal-
ysis (see UM-MetIDQ-Carbon-#.pdf) 
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It is required that the regional settings on the PC were Xcalibur™ and MetIDQ™ are 
installed to be set to “English US”. In addition, verify that “point” for “decimal symbol” and 
“comma” for “digit grouping symbol” are defined. Go to Windows Control Panel > Regional 
and Language > Formats > Additional Settings > Numbers. 
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3 Safety Instructions 

3.1 Safety Instruction for Personnel Protection 
The mobile phases (solvents) and reagents are chemical substances classified as “hazard-
ous substances”. The sample preparation must be carried out in a fume hood in a laboratory 
or other location in full compliance with local guidelines. Due to the use of dangerous sol-
vents (e.g. methanol, acetonitrile), the UHPLC-MS system must be properly ventilated. The 
calibration standards are matrix-free. The quality controls are human plasma that was tested 
to be free from known pathogens (hepatitis B and C, HIV 1 and 2, syphilis). However, it 
should still be considered as potentially infectious. For this reason, we recommend treating 
the quality control samples and your samples with an equal level precaution. The Kit must be 
processed by trained personnel, such as MTA, CTA, BTA, or higher. 

3.2 Proper Disposal of Laboratory Waste 
Proper disposal of laboratory waste requires that all waste is collected and separated ac-
cording to their chemical composition. Unused ampules should be opened and contents dis-
posed as organic halogen-free solvent. 
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4 Instrumental Setup 

 

It is required that the laboratory staff is familiar and experienced with the 
mass spectrometer and the operating software. 

 

 
To avoid peak fronting or splitting of early eluting metabolites in LC-MS analysis, a “post 
injection mixing chamber” may be required. If a Thermo Scientific™ Vanquish™ without 
column switching valves is used, install a Viper™ capillary 0.13 x 350 mm (Thermo 
Scientific™ ordering number 6040.2335) between the autosampler and the UHPLC column. 

4.1 Acquisition Methods and Tune Files 

 
Acquisition Methods and Tune Files are not provided with the USB stick due to 
compatibility reasons with different front-end devices. 
 Create them according to sections 4.3 and 4.4. 

 

Acquisition Methods and Tune Files required for the p400 HR Kit: 

MS Instrument Q Exactive™ 
Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

KIT2 LC methods 
KIT2-LC1_1011.meth 
KIT2-LC2_1012.meth 

KIT2-LC1_1111.meth 
KIT2-LC2_1112.meth 

KIT2-LC1_1211.meth 
KIT2-LC2_1212.meth 

KIT2-LC1_1311.meth 
 

KIT3 FIA methods 
KIT3-FIA1_1011.meth 
KIT3-FIA2_1012.meth 

KIT3-FIA1_1111.meth 
KIT3-FIA2_1112.meth 

KIT3-FIA1_1211.meth 
KIT3-FIA2_1212.meth 

KIT3-FIA1_1311.meth 
KIT3-FIA2_1312.meth 

FIA SST method KIT3-
FIA_SST_1011.meth 

KIT3-
FIA_SST_1111.meth 

KIT3-
FIA_SST_1211.meth 

KIT3-
FIA_SST_1311.meth 

Tune files 

KIT2-LCtune1_101x. 
mstune 

KIT2-LCtune2_101x. 
mstune 

KIT3-FIA_101x. 
mstune 

KIT2-LCtune1_111x. 
mstune 

KIT2-LCtune2_111x. 
mstune 

KIT3-FIA_111x. 
mstune 

KIT2-LCtune1_121x. 
mstune 

KIT2-LCtune2_121x. 
mstune 

KIT3-FIA_121x. 
mstune 

KIT2-LCtune1_131x. 
mstune 

KIT2-LCtune2_131x. 
mstune 

KIT3-FIA_131x. 
mstune 
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4.2 Quantitation Methods 
Quantitation methods for the LC part are provided on the USB stick for each Q Exactive™ 
platform. 
 

MS Instrument Q Exactive™ Focus Q Exactive™ 

LC variant UHPLC UHPLC 

KIT2 LC 
quantitation methods 

KIT2-LC1_XcaliburQuan_1011.pmd 
KIT2-LC2_XcaliburQuan_1012.pmd 

KIT2-LC1_XcaliburQuan_1111.pmd 
KIT2-LC2_XcaliburQuan_1112.pmd 

 

MS Instrument Q Exactive™ Plus Q Exactive™ HF 

LC variant UHPLC UHPLC 

KIT2 LC 
quantitation methods 

KIT2-LC1_XcaliburQuan_1211.pmd 
KIT2-LC2_XcaliburQuan_1212.pmd 

KIT2-LC1_XcaliburQuan_1311.pmd 
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4.3 Create Tune Files 

 
Each Tune File is specific for one Q Exactive™ instrument and must be created on that PC 
that is connected to the operated Q Exactive™ instrument. 
Create the required Tune Files according to the description below. 

 

Step Instruction Example 

1 Open the “Tune” window. 
 

2 
Create three Tune Files for your Q Exac-
tive™ platform. The Tune File names are 
shown below. 

 

 

MS Instrument Q Exactive™ 
Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

Tune files 

KIT2-LCtune1_101x. 
mstune 

KIT2-LCtune2_101x. 
mstune 

KIT3-FIA_101x. 
mstune 

KIT2-LCtune1_111x. 
mstune 

KIT2-LCtune2_111x. 
mstune 

KIT3-FIA_111x. 
mstune 

KIT2-LCtune1_121x. 
mstune 

KIT2-LCtune2_121x. 
mstune 

KIT3-FIA_121x. 
mstune 

KIT2-LCtune1_131x. 
mstune 

KIT2-LCtune2_131x. 
mstune 

KIT3-FIA_131x. 
mstune 

 

3 
For each Tune File use the parameters 
shown in section 10.3 MS Settings and 
Tune Files.  10.3 MS Settings and Tune Files 
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4.4 Create Acquisition Methods 

 
Acquistion Methods are specific for a LC-MS instrument combination and must be created 
on that PC that is connected to the operated Q Exactive™ instrument. 
Create the required Acquisition Methods according to the description below. 

 

Step Instruction 

1 Open the “Instrument Setup”. 
 

2 
Create all Acquisition Methods for your Q Exactive™ platform. 
The Acquisition Methods file names are shown below. 

 
For Q Exactive™ HF, only one LC method (combined Full MS + PRM) is used. 

 

MS Instrument Q Exactive™ 
Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

LC variant UHPLC UHPLC UHPLC UHPLC 

KIT2 LC methods 
KIT2-LC1_1011.meth 
KIT2-LC2_1012.meth 

KIT2-LC1_1111.meth 
KIT2-LC2_1112.meth 

KIT2-LC1_1211.meth 
KIT2-LC2_1212.meth 

KIT2-LC1_1311.meth 
 

KIT3 FIA methods 
KIT3-FIA1_1011.meth 
KIT3-FIA2_1012.meth 

KIT3-FIA1_1111.meth 
KIT3-FIA2_1112.meth 

KIT3-FIA1_1211.meth 
KIT3-FIA2_1212.meth 

KIT3-FIA1_1311.meth 
KIT3-FIA2_1312.meth 

FIA SST method KIT3-
FIA_SST_1011.meth 

KIT3-
FIA_SST_1111.meth 

KIT3-
FIA_SST_1211.meth 

KIT3-
FIA_SST_1311.meth 

 

Note: no acquisition methods are provided with the USB stick. 
 

3 
For each Acquisition Methods use the 
parameters shown in section 10.3 MS 
Settings and Tune Files.  

10.3 MS Settings and Tune Files 
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4.5 Link Tune Files to Acquisition Methods 
Step Instruction Example 

4 

On the PC that operates the Q Exactive™ 
instrument (hereinafter MS-PC), create a 
new folder structure on the C: drive. 
Information: these described folder names 
will be used in the following instructions. 

e.g. 

 

 
To be able to link a Tune File to an Xcalibur™ acquisition method, all methods have to 
be located on the C: drive. 

5 

Copy all required 
- acquisition methods 
- quantitation methods 
- tune files 

into the folder “Methods” on the MS-PC, 
according to section 4.1 and 4.2. 

 

6 
To view or edit an acquisition method, 
start Xcalibur™ and open the Instrument 
Setup. 
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Step Instruction Example 

 1st LC Method (all Q Exactive™ types) 

 Two tune files are linked to each LC acquisition method. 

7 
Open the 1st KIT2-LC acquisition method: 
- KIT2-LC1_1x11.meth 

 

8 
Activate the MS part of the method by 
clicking on the “Q Exactive - Orbitrap” 
icon.  

9 Expand the “Tune Files” section. 

 

10 

Link the 1st tune file: 
In the dialogue “Properties of Tunefiles” 
define the “Base Tunefile” under General 
by clicking on the  button. 
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Step Instruction Example 

11 

Select the tune file 
- KIT2-LCtune1_1x1x.mstune 
The tune file is located in the Methods 
folder, e.g. “Biocrates Kits/Methods”.  

12 

Link the 2nd tune file: 
In the dialogue “Properties of Tunefiles” 
define the “New Tunefile” under Ele-
ment 1 by clicking on the  button. 

 

13 
Select and link the tune file 
- KIT2-LCtune2_1x1x.mstune 
Click “Save” in the acquisition method. 

 
 2nd LC Method (not applicable to Q Exactive™ HF) 

14 
Open the 2nd KIT2-LC acquisition method: 
- KIT2-LC2_1x12.meth 

 

15 

Link the 1st and 2nd tune files in the acqui-
sition method “KIT2-LC2_1x12.meth”: 
- KIT2-LCtune1_1x1x.mstune 
- KIT2-LCtune2_1x1x.mstune 
For this, repeat steps 8 – 13. 
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Step Instruction Example 

 FIA Methods 

 One tune file is linked to each FIA acquisition method. 

16 

To each FIA acquisition method: 
- KIT3-FIA1_1x11.meth 
- KIT3-FIA2_1x12.meth 
- KIT3-FIA_SST_1x11.meth 
link the tune file 
- KIT3-FIA_1x11.mstune 

 

17 

Open the FIA acquisition methods one by 
one and link the FIA tune file 
“KIT3-FIA_1x11.mstune” as described 
above for the LC methods. 
Note: Only one tune file per FIA method 

is used. 
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4.6 Autosampler and pump settings in the acquisition methods 
 

 For pump and autosampler settings refer to the appendix 10.1 Pump Settings and 10.2 Au-
tosampler and Column Oven settings. 

 
The following plate types must be selected for the corresponding autosampler: 

- Vanquish™: “WellPlate96” 
- UltiMate™ 3000: “96-Deepwells” 

See section 10.2 Autosampler and Column Oven settings. 
 

Kit installation only: to adjust the settings of your autosampler for the p400 HR Kit, use the 1 mL 96 
deep-well plate with a silicone mat that you received with the Kit Setup Box. 
• Check the needle penetration of the selected plate type “WellPlate96” (for Vanquish™) or 

“96-Deepwells” (for UltiMate™ 3000). A good value is approximately 0.1 mm above the 
bottom of the well. 

 

Integrate rinsing steps to avoid cross contamination. 
Wash solvents see 5.4 Autosampler Wash Solvents. 
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Vanquish™ Autosampler settings 
 

Step Instruction Example 

1 
Open the “Direct Control” of the SII inter-
face. In the “SamplerModule” tab, select 
“More Options…”. 

 

2 

Define “100 [µm]” for “Needle Height”. 
Press the Enter key on the keyboard to 
confirm this setting and close the “More 
Options” window. 
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4.7 UHPLC System 
 

Solvents: Solvent A and Solvent B (see 5.2) 
 

UHPLC gradient – LC part 
Methods: KIT2-LC1_1x11.meth  and  KIT2-LC2_1x12.meth 

No Time(min) Flow (mL/min) %B Curve  
1 0.00 Run 

 

 

2 0.00 0.8 0.0 5 
3 0.25 0.8 0.0 5 
4 1.50 0.8 12.0 5 
5 2.70 0.8 17.5 5 
6 4.00 0.8 50.0 5 
7 4.50 0.8 95.0 5 
8 4.70 1.0 95.0 5 
9 5.10 1.0 95.0 5 
10 5.25 1.0 0.0 5 
11 5.80 0.8 0.0 5 
12 5.81 Stop Run 

 

Gradient – FIA part 
Methods: KIT3-FIA1_1x11.meth, KIT3-FIA2_1x12.meth  and  KIT3-FIA_SST_1x11.meth 

No Time(min) Flow (mL/min) %B Curve  
1 0.00 Run 

 

2 0.00 0.05 0.0 5 
3 1.40 0.05 0.0 5 
4 1.60 0.20 0.0 5 
5 2.80 0.20 0.0 5 
6 3.00 0.05 0.0 5 
7 3.01 Stop Run 

 

 

Column cleaning: It is recommended to clean the column after each plate for at least 30 min 
using the Wash Solvent (see section 5.4, page 37). Change the pre-column at 
least after the analyses of every three Kits. 

Column storage: 100% acetonitrile. 
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5 Preparing Solvents 

    

Follow lab safety procedures. 
Use fume hood and gloves. 
Dispose organic solvents properly. 

 

 

Testmix vials are provided with each Kit. Perform a system suitability test 
(SST) for the LC and FIA parts with the testmixes in order to check the in-
strument performance before starting with the Kit preparation. See section 
6 System Suitability Test (SST) for instructions. 
If the SST fails, do not start with the Kit preparation! Otherwise you will not 
be able to analyze your samples reliably and may lose sample information. 
Perform troubleshooting and contact Biocrates® Customer Support if neces-
sary. If you need our technical support, the testmix data files are required. 

5.1 Preparing Mobile Phases and Solvents 

5.2 LC Part – Solvent A and B 
Mobile Phase Description 

Solvent A (1000 mL) 1000 mL water + 2 mL formic acid 

Solvent B (500 mL) 500 mL acetonitrile + 1 mL formic acid 
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5.3 FIA Part – FIA Solvent 
Follow the instructions below to open the glass ampule (FIA Mobile Phase Additive) and to 
prepare the FIA Solvent. Use freshly prepared solvents only. You will find two ampules in the 
Kit box, one is sufficient to make enough FIA Solvent for one Kit. The second is a spare one, 
in case of a mistake or if you want to run a Kit plate again. 

Step Instruction Example 

1 
Find the white dot above the neck of the 
ampule. 

 

2 

Use glass-handling safety gloves when 
breaking the ampule open. 
 

Hold the ampule upright in one hand, then 
grip the top of the ampule firmly between the 
thumb and forefinger, placing your thumb on 
the white dot. 
 

Snap off the top of the ampule by bending it 
sharply backwards.  

3 

Mix the contents of the ampules with 290 mL 
of methanol to make the FIA Solvent. 

 

FIA Solvent (300 mL) = 290 mL methanol + 1 ampule FIA Mobile Phase Additive 

 The empty ampule can be handled as common laboratory waste. Do not recycle empty ampules. 
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5.4 Autosampler Wash Solvents 
Prepare 500 mL of each solvent for one Kit. 

Solvent Description 

Wash Solvent 

25% acetonitrile, 25% methanol, 25% isopropanol, 25% water 
 

125 mL acetonitrile + 125 mL methanol + 125 mL isopropanol + 
125 mL water 
 

Seal Wash 

Thermo Vanquish ™:   75% isopropanol, 25 % water and 0.1 % FA 
Thermo UltiMate™ 3000 RS:   10% methanol, 90 % water 
 

Other systems: as recommended by the manufacturer 
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6 System Suitability Test (SST) and Instrument Calibration 
The System Suitability Test (SST) is used to check the UHPLC-MS system performance 
before starting with the preparation of the AbsoluteIDQ® p400 HR Kit. Use the system set-
tings described in this section. All required instrument method parameters are shown in sec-
tions 10.1, 10.2 and 10.3. Follow the instructions for your LC-MS instrumental setup. 

 
LC-MS instrument method parameters: 
 

 10.1 Pump Settings 
 10.2 Autosampler and Column Oven settings 
 10.3 MS Settings and Tune Files 

 

 

 

If the SST fails, do not start with the Kit preparation. Perform troubleshooting 
or contact Biocrates® Customer Support. The system may not be sensitive 
enough to detect all metabolites, especially in the concentration range of 
lower calibration standard levels. 

6.1 Cleaning of LC-MS/MS System 

 Clean the entire LC-MS system before using the AbsoluteIDQ® p400 HR Kit. 

 

Step Instruction 

1 Clean the Ion Sweep Cone of the MS instrument. 

2 Clean the Ion Transfer Tube. 

3 Install all Wash Solvents and prime. 

4 
Install all solvents (Solvent A, Solvent B, FIA Solvent) and purge the lines. 
Flush all LC capillaries using all three solvents. 
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6.2 Prepare Blank and Testmix 
Two testmix vials are provided with each Kit, one for the LC part and one for FIA part. The 
testmix vials are matrix-free and do not contain internal standards. The Testmix LC contains 
all amino acids and biogenic amines that are measured in the LC part. The Testmix FIA con-
tains exemplary metabolites of the FIA part. The SST must be passed successfully before 
using the Kit. 
 

Testmix LC vial Testmix FIA vial 

 
 

 

Item Preparation 

Blank LC Add 1000 µL of 50% methanol (in water) to an empty vial. 

Testmix LC Add 600 µL of 50% methanol (in water) to the vial “Testmix LC”. 

Blank FIA Add 1000 µL of FIA Solvent (see 5.3, page 36) to an empty vial. 

Testmix FIA Stock Add 200 µL of 90% methanol (in water) to the vial “Testmix FIA”. 

Testmix FIA 
1. Add 2000 µL of FIA Solvent (see 5.3, page 36) to an empty vial. 
2. Add 10 µL of Testmix FIA Stock. 

 

All vials Vortex the testmix vials for 15 sec. Store at +4 °C until use. 
 

 

Dissolve testmix vials shortly before use. The reconstituted testmix can be stored for 1 
week at +4 °C. 
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6.3 Mass Calibration of the Q Exactive™ 

 

Always perform a mass calibration before starting with the Kit. Perform a “Calmix 
Evaluation” with “Positive ion evaluation”. 
 For a mass calibration or evaluation refer to the Q Exactive™ user manual. 
The p400 HR Kit analyzes metabolites with a mass below 100 Da. For this a 
“Customized Calibration” in positive ion mode is required. Follow the manufacturer’s 
instructions for calibrating the MS system. 

 

 The following procedure is described for a Q Exactive™ Focus and may differ slightly 
when another Q Exactive™ type is used. 

6.3.1 Calibration Solution for Customized Mass Calibration 
To ensure high mass accuracies for the AbsoluteIDQ® p400 HR Kit, perform a customized 
mass calibration using the following Calibration Solution: 

Item Preparation 

Customized 
Calibration Solution 

1. Add 1 mL of “Thermo Scientific™ Pierce LTQ Velos ESI Positive Ion 
Calibration Solution” to an empty vial. 

2. Add 100 µL of Testmix FIA Stock (see 6.2). 
 

 
Ordering information: 
Thermo Scientific™ Pierce LTQ Velos ESI Positive Ion Calibration Solution 
- Thermo Scientific™ ordering number PI-88323 
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6.3.2 Instrument Calibration 
Step Instruction Example 

1 Open the “Tune” window. 
 

2 Turn on the MS.  

3 
Load that Tune File that is used for in-
strument calibration. 

 

4 

In the “Instrument Control” panel go to 
“Scan parameters”. Define the values as 
shown on the right. 
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Step Instruction Example 

5 

Inject the Customized Calibration Solution: 
- Fill the syringe for direct infusion with 

Customized Calibration Solution 
(see 6.3.1, page 41) 

- Install the syringe, flush the lines and 
apply a flow of 10 µL/min 

- Wait for a stable TIC signal 

 
 

If the signal is not stable: 
1. Vary flow rate between 10-

20 µL/min 
2. Vary gas flow parameters 

Sheath gas: approx. 7 - 15 
Aux gas: approx. 1 - 3 
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Step Instruction Example 

6 

Perform a Customized Calibration: 
- Go to the “Calmix Calibration” tab and 

select “Mass Calibration (pos)” 
- Select “Customized Calibration” 
- 10 components are used for calibra-

tion, use the masses shown in the 
screenshot on the right. 

 

Masses for “Customized Calibration”: 

No m/z 
1 74.09643 
2 116.07061 
3 195.08765 
4 262.63612 
5 356.18327 
6 524.37107 
7 622.44423 
8 731.60615 
9 790.63203 
10 1121.99702 

 

 
 

 
Keep this window open during the 
calibration process. 

 

 

This table is available on the USB stick: 
- Folder: System Suitability Test\Customized Calibration 
- File: Masses for Customized Calibration.xlsx 

7 To start the calibration click “Calibrate”  
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Step Instruction Example 

8 Wait until the calibration was performed. 

 

9 

Open the Thermo Calibration Report, 
saved by default in this folder: 
“c:\xcalibur\system\exactive\instrument\ 
reports” 
 

Verify that all masses on page 1 and 2 
were detected in all scans and there are 
no zero values. 
 If not, repeat the Customized Cali-

bration using a higher flow rate. 

 
 

 

 Only if Customized Calibration fails repeatedly, split calibration. See steps 10 – 14. 

10 

1st Customized Calibration: 
• Select the tab Customized Calibration 
• Activate the first 9 masses 

• Click  

 

11 
Verify the Thermo Calibration Report 
according to step 9. 
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Step Instruction Example 

12 

2nd Customized Calibration: 
• Select the tab Customized Calibration 
• Activate the last 4 masses 

• Click  

 

13 
Verify the Thermo Calibration Report 
according to step 9. 

 

14 

Go to Instrument Status > Control > Mass 
Calibration Data > MCal (positive ions) > 
Higher order shape. 
 

Check that both calibrations from steps 10 
and 12 are linked. 
 If not, repeat steps 10 and 12. 

 

 If required, deactivate other calibrations. 
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6.4 Conditioning the UHPLC Column 
Step Instruction 

1 
Install the analytical column together with the pre-column (incl. pre-column holder) and flush 
the column for 20 min with 95% Solvent B at a flow rate of 0.5 mL/min. 

2 
Before the first injection, equilibrate the system at starting condition 
(100% Solvent A, flow rate 0.8 mL/min, column oven temperature 50 °C). 

3 Perform the SST (see next section). 

 Only if the SST fails due to insufficient cleaning, e.g. contaminations in blank, do the follow-
ing steps. 

4 Change all tubings, if possible. 

5 Install a new ESI electrode, if required. 

6 Clean all switching valves. 

7 Repeat all instructions described in section 6.1 Cleaning of LC-MS/MS System. 

6.5 Perform the System Suitability Test 
The System Suitability Test (SST) is used to check the UHPLC-MS system performance before 
the AbsoluteIDQ® p400 HR Kit is prepared. Use each method with the parameters as described 
in Appendix 10.1, 10.2 and 10.3. 

 Use ESI probe position ring B. 
 

 

Perform the SST before starting with the Kit. If the SST fails, do not start with 
the Kit preparation and perform troubleshooting! If required, contact Thermo 
or Biocrates® Customer Support. 
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6.5.1 SST – LC part 
Use the appropriate acquisition method “KIT2_LC1_1x11.meth” for your Q Exactive™ 
instrument. 
 

MS Instrument Q Exactive™ 
Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

LC variant UHPLC UHPLC UHPLC UHPLC 

KIT2 LC methods KIT2-LC1_1011.meth KIT2-LC1_1111.meth KIT2-LC1_1211.meth KIT2-LC1_1311.meth 

Tune files 

KIT2-LCtune1_101x. 
mstune 

KIT2-LCtune2_101x. 
mstune 

KIT2-LCtune1_111x. 
mstune 

KIT2-LCtune2_111x. 
mstune 

KIT2-LCtune1_121x. 
mstune 

KIT2-LCtune2_121x. 
mstune 

KIT2-LCtune1_131x. 
mstune 

KIT2-LCtune2_131x. 
mstune 

Use the blank LC and Testmix LC vials prepared in section 6.2 for the SST. 
 

Step Instruction 

1 
Use the acquisition method KIT2-LC1_1x11.meth for the LC SST for the used Q Exactive™ 
platform according to the table shown above. 

 
An overview of all methods is given in section 4.1. 
Do not rename any method file! 

2 
Double-check all parameters in the acquisition method for all instrument parts (MS, pump, 
autosampler, column oven). 
If necessary, type in the correct parameters according to Appendix 10.1, 10.2 and 10.3. 

3 Open the “Tune” window and turn on the instrument. 

 4 Load the Tune File   KIT2-LCtune1_1x1x.mstune 

 Before starting an injection, wait until all LC-MS parameters are stable. 

5 Place the blank LC vial and Testmix LC vial into the cooled autosampler tray. 
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Step Instruction 

6 

Create a sample sequence: 
- 3x blank LC 
- 3x testmix LC 
- 2x blank LC 

by loading the Xcalibur™ sequence “Sequence_p400_LC-SST.sld”, 
provided with the USB stick in the folder “System Suitability Test\Secquences”.  
Injection volume: 5 µL 

7 Load the acquisition method KIT2-LC1_1x11.meth in the Xcalibur™ sequence, e.g. 
 

8 
Define the correct well positions of the blank LC and Testmix LC 
vials, e.g. 

Vanquish™ UltiMate™ 

  
 

9 Submit the sequence.  

 An example testmix file (.raw) is located on the USB stick in the folder “Testmix Files”. Use 
these data to check the testmix performance of your LC-MS system. 
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Step Instruction 

10 

Figure 1 shows the TIC of an example chromatogram of a Testmix LC injection. 
MS instrument: Thermo Scientific™ Q Exactive™ Focus 
Pump system: Thermo Scientific™ Vanquish™ 
Acquisition method: KIT2-LC1_1011.meth 
 

Note: The testmix does not contain internal standards. 
 

 
Figure 1: Example Testmix LC chromatogram measured with Thermo Vanquish™ + Q Exactive™ 
Focus. 
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Step Instruction 

11 

To evaluate the Testmix LC performance use the Qual Browser layout “KIT2_SST.lyt” 
provided with the USB stick in the folder “System Suitability Test\Layouts”. 

 To apply a layout go to File > Layout > Apply… and select “KIT2_SST.lyt”. 

An exemplary Testmix LC chromatogram is also provided with the USB stick. See folder 
“Testmix Files”. 

12 
The retention time (RT) of each analyte must be stable over all three Testmix LC injections. 
If not, perform troubleshooting according to Biocrates® online FAQ, section LC Troubleshooting. 

 
Biocrates® FAQ: https://support.biocrates.com/tiki-index.php 

https://support.biocrates.com/tiki-index.php?page=LC+Troubleshooting
https://support.biocrates.com/tiki-index.php
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Step Instruction 

13 

Figure 2 shows an example chromatogram of a Testmix LC injection using the following 
setup: 
MS instrument: Thermo Scientific™ Q Exactive™ Focus 
Pump system: Thermo Scientific™ Vanquish™ 
Acquisition method: KIT2-LC1_1011.meth 
Qual Browser layout: KIT2_SST.lyt 
 

 
Figure 2: Example Testmix LC chromatogram with layout “KIT2_SST.lyt” applied. Acquired with a 
Thermo Vanquish™ + Q Exactive™ Focus. 
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Step Instruction 

14 

To evaluate the Testmix LC performance, use these SST criteria. 
 

SST criteria: 
• Rows 3-7: blank chromatograms should not show any peaks 
• Rows 2-7: stable RTs over three Testmix LC injections, maximum tolerance ±0.02 min 
• Rows 2-4: early eluting peaks do not show significant broadening, fronting, tailing or splitting 
• Row 5: good separation of ADMA and SDMA peaks (see chromatogram below) 
• Row 7: peak height of at least 2.0E6 cps 
• Row 8: the backpressure profile should not show any ripples (not shown for all pump systems) 

 

Row 5 – ADMA and SDMA peak separation: 
 

 

 No internal standards are included in the testmix. 
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Step Instruction 

15 

Check autosampler settings for injections from 96 deep well plates (first Kit use only): 
• Transfer 100 µL from the reconstituted vial “Testmix LC” into well positons A1 and H12 of 

an empty 1 mL deep-well plate, provided with the first Kit order. 
• Make one injection from both well positions A1 and H12 

using the acquisition method “KIT2-LC1_1011.meth”. 
• Apply the Qual Browser layout “KIT2_SST.lyt”. 
• Compare the obtained chromatograms with the ones acquired during the LC SST. 
• All peak intensity in rows 2-7 should be comparable with the ones from the LC SST. 
 If the peak intensities are reduced, it is possible that less than the specified sample 

volume was injected. Check the autosampler settings described in section 10.2 
Autosampler and Column Oven settings. 

 If the SST meets the required criteria continue with the SST for the FIA part. 

 
If the SST fails, the system may not be sensitive enough to detect all metabolites. 
Double-check the LC-MS configuration, instrument method parameters, and clean the entire 
LC-MS system according to the chapters 4 and 5. Perform the SST again. 
Please feel free to contact the Customer Support whenever you have questions. 

 

If the SST fails, do not start with the Kit preparation! Otherwise you may not be able to 
analyze your samples reliably and may lose sample information. Perform trouble-
shooting and contact Biocrates® Customer Support. 
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6.5.2 SST – FIA part 
Use the appropriate acquisition method “KIT3_FIA_SST_1x11.meth” for your Q Exactive™ 
instrument. 
 

MS Instrument Q Exactive™ 
Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

FIA SST method KIT3-
FIA_SST_1011.meth 

KIT3-
FIA_SST_1111.meth 

KIT3-
FIA_SST_1211.meth 

KIT3-
FIA_SST_1311.meth 

Tune files KIT3-FIA_1011. 
mstune 

KIT3-FIA_1111. 
mstune 

KIT3-FIA_1211. 
mstune 

KIT3-FIA_1311. 
mstune 

 

Use the blank FIA and Testmix FIA vials prepared in section 6.2 for the SST. 
 

Step Instruction 

1 
Use the acquisition method KIT3-FIA_SST_1x11.meth for the FIA SST for the used Q Exac-
tive™ platform according to the table shown above. 

 
An overview of all methods is given in section 4.1. 
Do not rename any method file! 

2 
Double-check all parameters in the acquisition method for all instrument parts (MS, pump, 
autosampler, column oven). 
If necessary, type in the correct parameters according to Appendix 10.1, 10.2 and 10.3. 

3 
Prepare the autosampler for FIA by one of the following options: 
- Remove the column and, if possible, connect the injector directly with the ion source.   or 
- Use a bypass or another column line (without a column installed). 

 
For good FIA peaks minimize dead volumes by using as few connecting parts as possible. 

4 Flush the system with the FIA Solvent at a flow rate of 0.2 mL/min for 10 min. 
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Step Instruction 

5 Open the “Tune” window and turn on the instrument. 

 6 Load the Tune File   KIT3-FIA_1x11.mstune 

 
Before starting an injection, wait until all LC-MS parameters are stable. 

7 Open the “Direct Control” window and lower the lower pressure limit to 0 bar. 
 

8 Place the blank FIA vial and Testmix FIA vial in the cooled autosampler tray. 

9 

Create a sample sequence: 
- 3x blank FIA 
- 3x testmix FIA 
- 2x blank FIA 

by loading the Xcalibur™ sequence “Sequence_p400_FIA-SST.sld”, 
provided with the USB stick in the folder “System Suitability Test\Secquences”. 
Injection volume: 20 µL 

10 
Load the acquisition method KIT3-FIA_SST_1x11.meth in the Xcalibur™ 
sequence, e.g.  

11 
Define the correct well positions of the blank FIA and Testmix FIA 
vials, e.g. 

Vanquish™ UltiMate™ 

  
 

12 Submit the sequence.  

 An example testmix file (.raw) is located on the USB stick in the folder “Testmix Files”. Use 
these data to check the testmix performance of your LC-MS system. 
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Step Instruction 

13 

Figure 3 shows the TIC of an example chromatogram of a p400 Kit Testmix FIA injection 
using the following setup: 
MS instrument: Thermo Scientific™ Q Exactive™ Focus 
Pump system: Thermo Scientific™ Vanquish™ 
Acquisition method: KIT3-FIA_SST_1011.meth 
 

 
Figure 3: Example Testmix FIA chromatogram measured with Thermo Vanquish™ + Q Exactive™ 
Focus. 

14 

To evaluate the Testmix FIA performance, use the Qual Browser layout “KIT3_SST.lyt”. 
This layout is provided with the USB stick in the folder “System Suitability Test\Layouts”. 
- An exemplary Testmix FIA chromatogram is provided with the USB stick. 

See folder “Testmix Files”. 
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Step Instruction 

15 

Figure 4 shows an example chromatogram of a Testmix FIA injection using the following setup: 
MS instrument: Thermo Scientific™ Q Exactive™ Focus 
Pump system: Thermo Scientific™ Vanquish™ 
Acquisition method: KIT3-FIA_SST_1011.meth 
Qual Browser layout: KIT3_SST.lyt 
 

 
Figure 4: Example Testmix FIA chromatogram with layout “KIT3_SST.lyt” applied. Acquired with a 
Thermo Vanquish™ + Q Exactive™ Focus. 
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16 

To evaluate the Testmix FIA performance, use the following SST criteria: 
 

SST criteria: 
• Rows 2-8: no major peak tailing or splitting 
• Rows 1-2 + 5-8: peak intensities of at least 1.0E7 cps 
• Rows 3-4: peak intensities of at least 1.0E6 cps 

 

 

 No internal standards are included in the testmix. 
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Step Instruction 

 If the SSTs of LC and FIA parts meet the required criteria you may start with the Kit prepara-
tion. 

 

If either the SST of the LC or FIA part fails, the system may not be sensitive enough to de-
tect all metabolites. 
Double-check the LC-MS configuration, instrument method parameters, and clean the entire 
LC-MS system according to the sections 4 and 5. Perform the SST again. 
 

 

If one or more rows do not show any intensities (“FIA peaks”), check the mass 
accuracy of the MS system. If needed, perform a mass calibration and an eFT 
parameter calibration. 
Note: There may be signals in Row 1 (TIC), even if the there is an issue with the 

MS mass accuracy. 
 

Please feel free to contact Biocrates® Customer Support whenever you have ques-
tions. 

 

If the SST fails, do not start with the Kit preparation! Otherwise, you may not be able 
to analyze your samples reliably and may lose sample information. Perform trouble-
shooting and contact Biocrates® Customer Support. 
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7 Kit Preparation 

 

The MetIDQ™ software is an integral part of the AbsoluteIDQ® p400 HR Kit. 
Please read the MetIDQ™ Carbon manual carefully (UM-MetIDQ-Carbon-#.pdf) 
and install Oracle® and MetIDQ™ before you start with the Kit. 
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7.1 Overview Kit Workflow 
The Kit workflow is described in detail in the following sections. For a proper Kit performance, do not 
combine the Kit with components from other manufacturers. 
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7.2 Overview Lab Workflow 
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7.3 Prepare Kit Components and Samples 
 

 
Dissolve all vials shortly before preparing the Kit. 

7.3.1 Phosphate Buffered Saline (PBS) 
PBS is used as Zero Sample, because the salt content is similar to plasma, resulting in comparable 
ion suppression and background noise. PBS can also be used when other sample material is ana-
lyzed. The limit of detection (LOD) for each metabolite is calculated by MetIDQ™. The LOD is defined 
as three times the background noise level. 
 

 
While PBS is recommended for blood based samples (e.g. plasma), alternatively the Zero 
Sample could be whatever the sample matrix. For example, when tissue extract samples are 
used, use this extraction solvent as Zero Sample. 

 

Zero Sample Instruction 

PBS Solution Prepare according to manufacturer‘s information. 

7.3.2 Internal Standard Mix (ISTD) 
Do not dissolve until use. Centrifuge the vial before opening at 10 000 x g for 2 min. 

Standard Instruction 

Internal Standard 
1. Add 1200 μL of water to the lyophilized ISTD. 
2. Shake for 15 min at 1200 rpm and vortex several times. 
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7.3.3 Calibration Standards (Cal1 – Cal7) 
Do not dissolve until use. Centrifuge the vials before opening at 10 000 x g for 2 min. The seven 
standards contain the amino acids and biogenic amines and are used to generate the calibration 
curves for the LC-MS part. 

Standard Instruction 

Biocrates® Standards 

1. Add 100 μL of water to each of the 7 Calibration Standards. 
2. Shake for 15 min at 1200 rpm and vortex several times. 
3. Gently tap the tubes on the table or use a centrifuge to make sure that 

the solution is at the bottom of the tube. 

7.3.4 Quality Control Samples (QC1 – QC3) 
Do not dissolve until use. Centrifuge the vials before opening at 10 000 x g for 2 min. The QC 
samples are human plasma based samples with analytes added in defined concentrations. QCs in 
three levels are provided. 
Note: We recommend pipetting QC2 after every 20th samples 

Sample Instruction 

QC Samples 
1. Add 100 μL water to each QC vial and shake for 15 min at 1200 rpm. 
2. Vortex the reconstituted QCs and centrifuge at 4 °C for 5 min at 2750 × g 

before loading onto the Kit plate. 

7.3.5 Plasma Samples 
Sample Instruction 

Plasma Samples 

If you analyze plasma samples with the Kit, vortex the plasma samples after 
thawing. Centrifuge at 4 °C for 5 min at 2750 × g (as the QCs) before load-
ing onto the Kit plate. Make sure that the centrifuge has reached a tempera-
ture below 20 °C before use. If the plasma samples are of high viscosity (i.e. 
plasma from small animals or of a certain diseased group), you should apply 
higher centrifugation speed (e.g. 5000 × g). 
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7.4 Preparing Solvents and Reagents 

7.4.1 Pre-Mix for Derivatization 
Solution Instruction 

1900 μL ethanol 
1900 μL water 
1900 μL pyridine 

1. Pipette 1900 µL (or 2 x 950 µL) of each solvent into the empty plastic tube 
that you find in the Kit box. 

2. Vortex for 10 sec. 

7.4.2 Phenylisothiocyanate (PITC) Derivatization Solution 
 

 
Prepare the solution directly before the derivatization! 
Note: The stability of the solution is reduced after adding PITC to the pre-mix. 

 

Solution Instruction 

Derivatization 
Solution 

1. Remove the PITC from the freezer and allow it to equilibrate to room 
temperature. 

2. Add 300 µL of fresh PITC to the pre-mix. 
3. Vortex rigorously until the solution is clear. 

7.4.3 Extraction Solvent 
This solution is stable for approx. three months after preparation. 

Solution Instruction 

5 mM ammonium 
acetate in methanol 

Dissolve 19 mg ammonium acetate in 50 mL methanol. 
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7.4.4 Mobile Phases 
For more details see sections 

- 5.2 LC Part – Solvent A and B 
- 5.3 FIA Part – FIA Solvent. 

 

LC part: 

Mobile Phase Description 

Solvent A (1000 mL) 1000 mL water + 2 mL formic acid 

Solvent B (500 mL) 500 mL acetonitrile + 1 mL formic acid 
 
FIA part: 

Mobile Phase Description 

FIA Solvent (300 mL) 290 mL methanol + 1 ampule FIA Mobile Phase Additive 
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7.4.5 Register the Kit Plate in MetIDQ 
Step Instruction Example 

1 

To register the Kit plate in MetIDQ™ follow 
the instructions of the MetIDQ™ Carbon 
user manual (UM-MetIDQ-Carbon-#.pdf) in 
section 4.1.4 Generate Plate Layout and 
Worklist for MS run. 

 

2 
When generating the worklist in MetIDQ > 
MetLIMS > Projects, use the appropriate 
MetIDQ™ OPs shown in the table below. 

 

 

 
For Q Exactive™ HF, only one LC method (combined Full MS + PRM) is used. 

   Create only one LC Plate Run using OP KIT2-0-1311. 
 

Instrument Q Exactive™ Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

LC OPs 
KIT2-0-1011 KIT2-0-1111 KIT2-0-1211 

KIT2-0-1311 
KIT2-0-1012 KIT2-0-1112 KIT2-0-1212 

FIA OPs 
KIT3-0-1011 KIT3-0-1111 KIT3-0-1211 KIT3-0-1311 

KIT3-0-1012 KIT3-0-1112 KIT3-0-1212  
 

 
Two injections are performed in both LC and FIA parts. For each injection, a separate 
MetIDQ™ OP and Xcalibur™ acquistion method is used. 
An example for a Q Exactive™ Focus is given below. 
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Example for a Q Exactive™ Focus: 

 Injection OP code Acquisition method Quantitation method 

LC 
1 KIT2-0-1011 KIT2-LC1_1011.meth KIT2-LC1_XcaliburQuan_1011.pmd 

2 KIT2-0-1012 KIT2-LC2_1011.meth KIT2-LC2_XcaliburQuan_1011.pmd 

FIA 
1 KIT3-0-1011 KIT3-FIA1_1011.meth no quantitation method 

quantified by MetIDQ™ 2 KIT3-0-1012 KIT3-FIA2_1012.meth 
 

3 

1. Register one LC Kit plate (Plate Run) 
using the OP “KIT2-0-1x11”. 

2. Once the LC plate layout is satisfactory, 
make three more copies of this Plate 
Run. 

3. Right-click on the plate entry and select 
“Copy”. 

4. Right-click again and “Paste derived 
plate” three times. 

5. Change the OPs of each newly created 
plate according to the table above 
according to your MS instrument. 

 
Example for a Q Exactive™ Focus 

4 
Generate the pipetting layout and 
autosampler worklist by selecting “Export 
Worklist for MS” in MetIDQ™. 
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7.4.6 Prepare the Kit Plate 

 
1. Make sure that all samples and the Kit plate layouts are registered in MetIDQ™ and that 

the MetIDQ™ acquisition batch file (.csv) for the Xcalibur™ software was generated. 

2. Find the AbsoluteIDQ® Kit plate in the Kit box. Remove the plastic bag and follow the 
step-by-step instructions below to prepare the assay. 

3. Follow lab safety protocol while preparing the Kit. Use a fume hood and gloves. 

 

QCs are used to ensure the accuracy and reproducibility of the analysis. It is recommended 
that QC2 is measured in replicates of 5 (after every 20 samples). 
QC2 replicates are required for inter-plate normalization (see Appendix “Data Normaliza-
tion“ in the MetIDQ™ Carbon user manual) in order to guarantee the best quality of your 
results. You may also refer to the EMEA guidelines on bioanalytical method validation 
(European Medicines Agency, 2011). 

 

 1 2 3 4 5 6 7 8 9 10 11 12 

A Blank Cal5           

B Zero Cal6   QC2     QC2   

C Zero Cal7           

D Zero QC1           

E Cal1 QC2           

F Cal2 QC3     QC2      

G Cal3            

H Cal4           QC2 
  

http://www.ema.europa.eu/ema/index.jsp?curl=pages/includes/document/document_detail.jsp?webContentId=WC500109686%26mid=WC0b01ac058009a3dc
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Step Instructions 

1 Remove the plastic lid of the AbsoluteIDQ® Kit plate. 

2 

Add 10 µL of the ISTD to all wells of the Kit plate with exception of the blank well position A1. 
Pipette directly onto the filter in the center of each well. Do not pipette on the wall of the 
wells. We recommend using an Eppendorf Multipette® (repeater) adjusted to maximum dis-
pensing speed. 
Do not use an 8-channel pipette! 

3 

Pipette 10 µL of each sample (Zero, Calibration Standards, QCs and experimental 
samples): 

Use a single-channel pipette to pipette 10 µL onto the center of each filter. Gently 
touch the filter inserts with the pipette tip while pipetting the samples. Do not pi-
pette on the wall of the wells and avoid cross-contamination. Use a fresh tip for 
each sample. 

 

Well A1   Blank: do not pipette anything Blank 

Well B1   Zero: pipette 10 µL of PBS 
Well C1   Zero: pipette 10 µL of PBS 
Well D1   Zero: pipette 10 µL of PBS 

Zero 

Well E1   Cal1: pipette 10 µL of Calibration Standard level 1 
Well F1   Cal2: pipette 10 µL of Calibration Standard level 2 
Well G1   Cal3: pipette 10 µL of Calibration Standard level 3 
Well H1   Cal4: pipette 10 µL of Calibration Standard level 4 
Well A2   Cal5: pipette 10 µL of Calibration Standard level 5 
Well B2   Cal6: pipette 10 µL of Calibration Standard level 6 
Well C2   Cal7: pipette 10 µL of Calibration Standard level 7 

Cal1-7 

Well D2   QC1: pipette 10 µL of Quality Control level 1 
Well E2   QC2: pipette 10 µL of Quality Control level 2 
Well F2   QC3: pipette 10 µL of Quality Control level 3 

QC1 
QC2 
QC3 

Well G2 – H12   pipette 10 µL according to the MetIDQ plate layout 
Samples 

QC2 
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Step Instructions 

4 
Dry down the samples for 30 min at room temperature under nitrogen, according to the fol-
lowing info box. 

 

Dry the samples: 
Use a Nitrogen Evaporator or Pressure Manifold. 
Nitrogen Evaporator: 

• Make sure the evaporator needles are at least 5 mm above the filter inserts. 

• Adjust the pressure at the nitrogen pressure reduction valve to about 3-4 bar and check 
that there is a nitrogen flow at the end of the evaporator needles. 

Pressure Manifold: 

• Refer to the “Instructions for Using a Pressure Manifold for p180, p400 and p150 Kit” on the 
USB stick located in the folder “Instructions”. 

5 Prepare the PITC Derivatization Solution, see section 7.4.2 (page 66). 

 
Use the PITC Derivatization Solution shortly after adding PITC to the Pre-Mix. 

6 
Pipette 50 μL of the PITC Derivatization Solution (see 7.4.2) to each well (incl. the blank, 
well A1). Pipette directly on the center of the filter. Do not pipette on the wall of the wells. We 
recommend the use of an Eppendorf Multipette® adjusted to medium dispensing speed. 

7 Cover the Kit plate with the plastic lid and incubate at room temperature for 25 min. 

8 
Remove the plastic lid. Dry the Kit plate with a Nitrogen Evaporator or Pressure Manifold 
(see info box above) for 60 min. 

 
Make sure the Kit plate is completely dried. Ineffective evaporation of PITC and pyridine will 
impair the Kit performance. 

9 
Add 300 μL of Extraction Solvent (see 7.4.3) to each well. Use an Eppendorf Multipette® 
(repeater) adjusted to low dispensing speed or an 8-channel pipette 
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Step Instructions 

10 
Cover the Kit plate with the plastic lid. Shake the Kit plate at room temperature using an 
Eppendorf® ThermoMixer® or MixMate® at 450 rpm for 30 min. 

 

Be careful when shaking the Kit plate with another shaker as specified in step 10. Due to the 
risk of cross-contamination, adjust the speed of the mixer carefully. Make sure there is no spill 
over. 

11 
Centrifuge the Kit plate for 2 min at 500 × g (make sure the centrifuge is balanced) or 
use a Pressure Manifold (see “Instructions for Using a Pressure Manifold for p180, p400 and 
p150 Kit” on the USB stick located in the folder “Instructions”). 

 
After the elution, check that the fill level is the same in all wells in the capture plate. 
If not, repeat the elution process and apply higher g or higher pressure, respectively. 

12 
Carefully remove the tape from the sides of the Kit plate. Separate the lower capture plate 
(containing the samples extracts, labeled “Use for FIA“) from the upper filter plate. Take care 
that nothing spills or splashes over during this process. 

 

In case of any delays, seal the capture plate with one of the silicon mats that you find in 
the Kit box and store it at 4 °C before continuing with the next steps. The plate can be 
stored up to two days at 4 °C. Do not store the plate below 0 °C! 

 The following preparation steps 13 – 16 should be performed immediately. 
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Step Instructions 

Q Exactive™ Focus / Q Exactive™ Plus / Q Exactive™ HF / Q Exactive™ 

 

For this step you need: 
• Capture plate labeled “Use for FIA“ from step 12 
• Empty 96-deepwell plate labeled “Use for LC“ (provided with the Kit box) 
• 2 silicone mats (provided with the Kit box) 

 

Make sure you transfer every extract exactly to the same well position of the empty deep 
well plate. We recommend the use of a multichannel pipette. 
Condition pipette tips: aspirate and dispense 3 times before transferring! 

 

It is strongly recommended to run the LC plate (labeled “Use for LC“) first, since biogenic 
amines show limited stability over a longer period after adding water. Run the LC plate latest 
the next day after preparation. 

13 The LC and FIA analyses are performed using two separate plates at different concentrations. 

14 

Dilute extracts for LC: 
Remove 150 μL from each well of the capture plate (labeled “Use for FIA“) and transfer it to 
the empty 96 deep well plate labeled “Use for LC“. 
 

Add 150 μL water to each well and seal the plate with a silicone mat. Make sure that the 
silicone mat is sealed completely on the plate. Firmly press the mat’s naps into the wells. 
Shake for 5 min at 500 rpm. 

15 

Dilute extracts for FIA: 
Use the plate labeled “Use for FIA”. Add 250 μL of FIA Solvent (see 7.4.4) to each well and 
seal the plate with a silicone mat. Make sure that the silicone mat is seated correctly on the 
plate. Firmly press the mat’s naps into the wells. Shake for 5 min at 500 rpm. 

16 Both plates, labeled “Use for LC“ and “Use for FIA“, are now ready for LC-MS and FIA-MS 
analysis, respectively. Place the sealed plates into the autosampler at 10 °C or store at 4 °C. 

 

In case of any delays store the plates at +4 °C. The autosampler stability is: 
• LC part: 2 days 
• FIA part: 7 days.   In case of extract evaporation, fill up the wells to the original vol-

ume with methanol and shake the plate. 
• Never store the LC plate or the FIA plate below 0 °C! 

17 Continue with section 7. 
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8 Processing the Kit Plate with the Mass Spectrometer 
Ensure that the mass spectrometer meets all manufacturer specifications and has been 
properly calibrated. Take care that the deep well capture plate (sealed with the silicone mat) 
is in the correct autosampler rack. For additional information, refer to the Biocrates® Video 
Tutorial: 

 
9B MS Measurement: Batch File/Acquisition Method Import for Thermo MS Instruments 

8.1 LC part 
We recommend running the LC-MS assay first. The autosampler stability of some biogenic 
amines is shorter compared to the analytes of the FIA part. For the LC-MS assay, the data 
processing and concentration calculation is performed using the Xcalibur™ software. For 
first time users, we recommend beginning with a 24-well Starter Kit before attempting a full 
plate. 

 Use ESI probe position ring B. 
 

Step Instructions 

1 Place the LC Kit plate in the autosampler. 

2 Open the “Tune” window and turn on the instrument. 

 3 Load the Tune File   KIT2-LCtune1_1x1x.mstune 

 Before starting an injection, wait until all LC-MS parameters are stable. 

https://www.youtube.com/watch?v=AThfub8Qqpo&list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk&index=10
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Step Instructions 

 

After each injection, MS parameters (e.g. Capillary Temperature) from the active Tune File 
are applied. To reduce batch run times and to guarantee reliable Kit performance, load the 
Tune File KIT2-LCtune1_1x1x.mstune before starting the Kit run. 
Note: If another Tune File is active, MS parameters (e.g. Capillary Temperature) may not be 

stable during a Kit run. 

 
Only continue with the next steps if the system suitability test passed. 
If not done before the Kit preparation perform a system suitability test according to section 
6.5.1 SST – LC part and 6.5.2 SST – FIA part 

4 
Before the first injection, equilibrate the system at starting conditions 
(100% Solvent A, flow rate 0.8 mL/min, column oven temperature of 50 °C). 

5 

Import the LC sequence file (.csv file, created by MetIDQ™ in section 7.4.5) into Xcalibur™ 
before starting with the mass spectrometer processing. 
Go to the Thermo Xcalibur™ Sequence Setup. 
1. From the menu bar, select File > Import Sequence. 
2. Click Browse. 
3. Successively import both .csv sequence file for the LC part. 

Note: In the “Import Sequence” Window keep all check-boxes selected. 
4. Click Open to import each file. 

6 

In the Xcalibur™ sequences check the columns Path, Inst Meth and Position. 
 

- Path: define folder where .raw files are written 
e.g. C:\Xcalibur\Biocrates Kits\Data 

- Inst Meth: selct folder where acquisition method is located, 
e.g. C:\Xcalibur\Biocrates Kits\Methods 

- Position: place the kit plate in the defined tray 
e.g. blue 
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Step Instructions 

 

The Path of the acquisitions methods in the Xcalibur™ sequence can be defined in Met-
IDQ™. Refere to the MetIDQ™ user manual (UM-MetIDQ-Carbon-#.pdf), section 4.1.5 Ex-
port Worklist for Kit measurement. 

 
 

 
 

 

7 
Before starting the Kit analysis, double-check each Xcalibur™ sequence. 
The Blank sample will be injected three times to condition the system. 

 
Do not rename or alter the samples, data files, or acquisition methods. Otherwise the 
data files will not be compatible with MetIDQ™. 

8 Submit the sequence and monitor the data from the first injections to ensure that the assay 
is running properly. 
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8.2 FIA part 

 Use ESI probe position ring B. 
 

 

The FIA part is more sensitive to autosampler contaminations than the LC part, as hundreds of 
lipids are analyzed. In our experience, autosamplers are often contaminated with lipids. Make 
sure that all system parts are cleaned and the background noise level is low. If necessary, 
clean the autosampler parts such as needle, needle seat, sample loop, or switching valves. 

 

Step Instructions 

1 

Remove the column and connect the autosampler directly to the ion source. Alternatively, a 
bypass or separate column line (without a column installed) can be used. In this case, make 
sure to have as few connecting parts as possible to minimize dead volume and obtain the 
best FIA “peaks”. Flush the system with the FIA Solvent. 

2 Place the FIA Kit plate in the autosampler. 

3 Open the “Tune” window and turn on the instrument. 

 4 Load the Tune File   KIT3-FIA_1x1x.mstune 

 Before starting an injection, wait until all LC-MS parameters are stable. 

 

After each injection, MS parameters (e.g. Capillary Temperature) from the active Tune File 
are applied. To reduce batch run times and to guarantee a good Kit performance load the 
Tune File KIT3-FIA_1x1x.mstune before starting the Kit run. 
Note: If another Tune File is active, MS parameters (e.g. Capillary Temperature) may not be 

stable during a Kit run. 

 Only continue with the next steps if the system suitability test (SST, see 6.5.2) passed. 

5 
Before the first injection flush all lines with FIA Solvent 
(100% FIA Solvent, flow rate 0.2 mL/min for 10 min). 
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Step Instructions 

6 

Import the FIA sequence file (.csv file, created by MetIDQ in section 7.4.5) into Xcalibur™ 
before starting with the mass spectrometer processing. 
Go to the Thermo Xcalibur™ Sequence Setup. 
1. From the menu bar, select File > Import Sequence. 
2. Click Browse. 
3. Successively import both .csv sequence file for the FIA part. 

Note: In the “Import Sequence” Window keep all check-boxes selected. 
4. Click Open to import each file. 

7 

In the Xcalibur™ sequences check the columns Path, Inst Meth and Position. 
 

- Path: define folder where .raw files are written 
e.g. C:\Xcalibur\Biocrates Kits\Data 

- Inst Meth: selct folder where acquisition method is located, 
e.g. C:\Xcalibur\Biocrates Kits\Methods 

- Position: place the kit plate in the defined tray 
e.g. blue 
 

 

8 
Before starting the Kit analysis, double-check each Xcalibur™ sequence. 
The Blank sample will be injected three times to condition the system. 

 
Do not rename the samples, data files, or acquisition methods. Otherwise the data 
files will not be compatible with MetIDQ™. 

9 Submit the sequence and monitor the data from the first injections to ensure that the assay 
is running properly. 
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Recommended cleaning of tubing and ESI electrode 
The FIA method operates at relatively low flow rates using biological samples and matrix, 
therefore, deposits can remain in the tubing or ESI electrode. It is recommended to integrate 
routine washing steps to ensure a robust performance of the Kit. We suggest the following or 
similar washing steps. 
 

1. Wash tubing and ESI probe for 60 min using water at a flow rate of 0.5 mL/min. 
2. Wash tubing and ESI probe for 60 min using isopropanol at a flow rate of 0.5 mL/min. 
3. Wash tubing and ESI probe for 20 min using FIA Solvent at a flow rate of 0.5 mL/min. 

 

Troubleshooting: One of the most likely reasons for instabilities in the FIA profile is that there 
are deposits in the ESI electrode or tubing. It is recommended to monitor the backpressure 
pressure profile during Kit runs (when the flow rate is at 0.2 mL/min). A significant increase in 
pressure is an indication for the need to clean or replace the ESI electrode or tubing. 
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9 Data Processing – LC Part 
The quantitation of the FIA part is performed automatically by the MetIDQ™ software and is de-
scribed in the software manual. The LC data quantitation is carried out in the Xcalibur™ soft-
ware. The quantitation process is based on a seven point calibration and internal standard nor-
malization. Relevant calibration parameters such as calibration standard concentrations can be 
found in the Analytical Specifications (“AS-p400-HR-#.pdf” on the USB stick). Follow the instruc-
tions in this section or review the following Biocrates® Video Tutorial: 

 
10C Thermo MS Measurement: Quantitation, Result File Import, Validation in MetIDQ 

9.1 Quantitation Method 
The required quantitation methods are provided with the Kit USB stick. Use the appropirate 
quantitation methods for your Q Exactive™ and update the retention times (see next section). 
 

MS Instrument Q Exactive™ Focus Q Exactive™ 

LC variant UHPLC UHPLC 

KIT2 LC 
quantitation methods 

KIT2-LC1_XcaliburQuan_1011.pmd 
KIT2-LC2_XcaliburQuan_1012.pmd 

KIT2-LC1_XcaliburQuan_1111.pmd 
KIT2-LC2_XcaliburQuan_1112.pmd 

 

MS Instrument Q Exactive™ Plus Q Exactive™ HF 

LC variant UHPLC UHPLC 

KIT2 LC 
quantitation methods 

KIT2-LC1_XcaliburQuan_1211.pmd 
KIT2-LC2_XcaliburQuan_1212.pmd 

KIT2-LC1_XcaliburQuan_1311.pmd 

https://www.youtube.com/watch?v=pHjDGMBgWJ4&list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk&index=14
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9.2 Adjust Retention Times 
Before starting with the quantitation process, adjust the retention times in the quantitation 
methods. 

Step Instructions Examples 

 LC injection 1 – Quantitation Method 

1 

Open the quantitation method 
KIT2-LC1_XcaliburQuan_1x11.pmd 
 or 
KIT2-LC1_XcaliburQuan_1311.pmd 
 – Q Exactive™ HF only – 

with the Xcalibur™ > Processing Setup. 

 

 

2 

Open the .raw file of Calibration Standard 
level 5 (Cal 5) acquired with the method 
KIT2-LC1_1x11.meth. 
 

Cal 5 has the barcode 1019338954 and is 
injected from well position 02 by default. 
1006062609 
 

Example file name of Cal 5: 
KIT2-0-1011_1025339648_ 
02_0_1_1_16_1019338954.raw 
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3 

Check the integration (under the “detection 
tab”) and RT (under the “Identification” tab) 
of every analyte and internal standard. 

If required, adjust the 
 

- Retention time (RT) 

- Peak integration parameter 
 

 To apply changes click “OK”. 

 

Finally save all changes.  

 

 

Peak integration: 

 

ADMA and SDMA: 
They have the same mass and are separated by chromatography. 

- 1st peak: ADMA 

- 2nd peak: SDMA 
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t4-OH-Pro and c4-OH-Pro: 
They have the same mass and are separated by chromatography. 

- 1st peak: t4-OH-Pro 

- 2nd peak: c4-OH-Pro 
 

 
Sarcosine: 
It is always the first peak. 

- 1st peak: sarcosine 
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Ac-Orn: 
It is always the second peak. 

Note: Using the Testmix LC there will only be one peak that is Ac-Orn. 

- Tesmtix LC: only 1 peak 

- Kit: 2nd peak 
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 LC injection 2 – Quantitation Method (not applicable to Q Exactive™ HF) 

4 
Open the quantitation method 
KIT2-LC2_XcaliburQuan_1x12.pmd 
with the Xcalibur™ > Processing Setup.  

5 

Open the .raw file of Cal 5 acquired with the 
method KIT2-LC1_1x12.meth, e.g. 
 

KIT2-0-1012_1025339652_ 
02_0_1_1_16_1019338954.raw 

 

6 

Check the integration of Ile and its internal 
standard (under the “detection tab”) and RT 
(under the “Identification” tab). 

If required, adjust the 
 

- Retention time (RT) 

- Peak integration parameter 
 

 To apply changes click “OK”. 

 

Finally save all changes.  
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9.3 Quantitation Procedure 
 

 

It is recommended to have an identical folder structure on both the MS-PC (PC that operates 
the instrument) and PC used for MS data quantitation. 

File name example: 

KIT2-0-1011_1013396222_01_0_1_1_01_10000001.raw 
 

OP-Name_plate barcode_well position_acquisition method_ 

run number_injection_number_Sample type ID_sample barcode 
 

Step Instructions Examples 

 

We recommend performing the quantitation on another PC, e.g. office PC. Copy all data (MS 
data, sequence list, quantitation methods) from the data acquisition PC (MS-PC) to the 
quantitation PC. 

 

Sequence lists for quantitation: 
Except for Q Exactive™ HF, two sequence lists with separate quantitation methods are 
required according to the 1st (LC1) and 2nd (LC2) injections. 
 
For Q Exactive™, Q Exactive™ Focus and Q Exactive™ Plus use: 
- KIT2-LC1_XcaliburQuan_1x11.pmd   and 
- KIT2-LC2_XcaliburQuan_1x12.pmd 
 
For Q Exactive™ HF use: 
- KIT2-LC1_XcaliburQuan_1311.pmd 
 
The required sample lists were generated by MetIDQ, see section 7.4.5. 
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Step Instructions Examples 

LC injection 1 – Quantitation (all Q Exactive™ types) 

1 

Open the sequence of LC injection 1 (acquisi-
tion method KIT2-LC1_1x11.pmd) in the Xcali-
bur™ Sequence Setup window. 

Make sure that the columns “Level” and “Proc 
Meth” are shown. They can be added via 
Change > Column Arrangement.... Also add 
the other columns which are shown in the list 
“Displayed Column” according to the screen-
shot (order not important). 

Click “Ok”.  

2 

Select the quantitation method: 

Double-click in the first cell of the column 
“Proc Meth” and select 

- KIT2-LC1_1x11.meth 

with updated retention times according to sec-
tion 9.2. 

 

3 

In the column “Level“, check the levels for cali-
bration standards and QCs. 

- Calibration standards: e.g. Cal 3 > Level 3 

- QCs: all QCs levels > Level 1 

 

Note: For all QCs, Level1 is used, as the 
accuracies are checked in MetIDQ™. 
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Step Instructions Examples 

4 

Start the quantitation process: 
1. Click on the button “Batch Reprocess Setup” 

2. Select  Quan 

Peak Detection & Integration 

Calibration 

Quantitation 

3. Click “OK”. 

 

 
The quantitation process can take several 
minutes. Wait until the processing window 
disappears. 

 
 During this process .rst files are created. 

5 

- Open Quan Browser. 

- Open the sequence list file (.sld) used for 
data acquisition and quantitation. 

- Select “Show All sample types” in the pop-
up window. 

- Evaluate the calibration curves and the 
peak integration. 

- Page through all analytes and ISTD, if nec-
essary adjust the peak integration. 
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Step Instructions Examples 

6 

Export the quantitation results: 

From the menu bar, select File > Export 
data to Excel > 
Export long Excel report 

The results are saved as Excel file (.xls) in the 
“Data” folder. 

 

LC injection 2 – Quantitation (not applicable to Q Exactive™ HF) 

7 

Open the sequence of LC injection 2 (acquisi-
tion method KIT2-LC2_1x12.pmd) in the Xcali-
bur™ Sequence Setup window. 

Make sure that the columns shown in the 
screenshot are visible. 

 

8 

Select the quantitation method: 

Double-click in the first cell of the column 
“Proc Meth” and select 

- KIT2-LC2_1x12.pmd 

with updated RTs, according to section 9.2. 
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Step Instructions Examples 

9 

In the column “Level“, check the levels for cali-
bration standards and QCs. 

- calibration standards: e.g. Cal 3 > Level 3 

- QCs: all QCs levels > Level 1 

 

Note: For all QCs Level1 is used, as the 
accuracies are checked in MetIDQ™. 

 

10 

Start the quantitation process: 
1. Click on the button “Batch Reprocess Set-

up”. 

2. Select  Quan 

Peak Detection & Integration 

Calibration 

Quantitation 

3. Click “OK”. 
 

The quantitation process can take several 
minutes. Wait until the processing window 
disappears. 
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Step Instructions Examples 

11 

- Open Quan Browser. 

- Open the sequence list file (.sld) used for 
data acquisition and quantitation. 

- Select “Show All sample types” in the pop-
up window or the “All” tab below the sam-
ple list. 

- Evaluate the calibration curves and the 
peak integration. 

- Page through all analytes and ISTD, if nec-
essary adjust the peak integration. 

 

 

12 

Export the quantitation results: 

From the menu bar, select File > Export 
data to Excel > 
Export long Excel report 

The results are saved as Excel file (.xls) in the 
folder “Data”. 

 

13 
Import the kit data into MetIDQ™: 
• Quantitation results (.xls files) from LC injection 1 and 2 
• MS data (.raw files) from FIA injections 1 and 2  

 The accuracy of the calculated QC concentrations is checked in MetIDQ™. The accuracies 
are calculated by MetIDQ™ and visualized in MetVAL after importing the result files (.xls). 

 

 

Please refer to the MetIDQ™ Carbon user manual section 5. Converting and Importing 
Mass Spectrometer Data. To evaluate the results and perform statistics, you can use 
the MetIDQ™ tool StatPack, as well as other tools such as MetaboAnalyst. 
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10 Appendix 

10.1 Pump Settings 
 

UHPLC Gradient for methods KIT2-LC1_1x11.meth and KIT2-LC2_1x12.meth 
 

No Time (min) Flow (mL/min) B (%) Curve 
1 0.00 Run 
2 0.00 0.8 0.0 5 
3 0.25 0.8 0.0 5 
4 1.50 0.8 12.0 5 
5 2.70 0.8 17.5 5 
6 4.00 0.8 50.0 5 
7 4.50 0.8 95.0 5 
8 4.70 1.0 95.0 5 
9 5.10 1.0 95.0 5 
10 5.25 1.0 0.0 5 
11 5.80 0.8 0.0 5 
12 5.81 Stop Run 
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FIA Gradient for methods KIT3-FIA1_1x11.meth, KIT3-FIA2_1x12.meth and 
 KIT3-FIA_SST_1x11.meth 
 

 

No Time (min) Flow (mL/min) B (%) Curve 
1 0.00 Run 
2 0.00 0.05 0.0 5 
3 1.40 0.05 0.0 5 
4 1.60 0.20 0.0 5 
5 2.80 0.20 0.0 5 
6 3.00 0.05 0.0 5 
7 3.01 Stop Run 
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10.2 Autosampler and Column Oven settings 

10.2.1 Thermo Vanquish™ 
 

Autosampler 
Parameter Value 

Wash Solvent 25% acetonitrile, 25% methanol, 25% isopropanol, 25% water 

Seal Wash 75% isopropanol, 25% water, 0.1% formic acid 

Needle Height 100 µm 

Plate Type 
ThermoVial54 (for testmix vials) 
WellPlate96 (for Kit plate) 

Post injection mixer 
Viper 0.13 x 35 mm capillary   or 
7-port column selection valve 

Speed parameters 
(of syringe) 

Draw speed LC: 1 µL/s 
 FIA: 2 µL/s 
Dispense speed 8 µL/s 

Wash procedure 
Wash mode Before Draw 
Wash time 5 sec 
Wash speed 32 µL/s 

Sample temperature 10 °C 
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Parameter Value 

Sampler Module 

 

 
 
Column Compartment 

Parameter Value 

Column Oven Temperature: 50 °C 

Column Pre-Heater Temperature: 50 °C 

Post Column Cooler Temperature: 40 °C 
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Parameter Value 

Column 
Compartment 

 
 
General Settings 

Parameter Value 

System 

LC FIA 
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Parameter Value 

Startup Shutdown 
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10.2.2 Thermo UltiMate™ 3000 RS 
 

Autosampler 
Parameter Value 

Wash Solvent 25% acetonitrile, 25% methanol, 25% isopropanol, 25% water 

Seal Wash 10% methanol, 90% water 

Plate Type 
40 Vials  (for testmix vials) 
96-Deepwells (for Kit plate) 

General/Injection 

Injection mode Normal 
Sample height 1 mm 
Puncture offset 0.0 mm 
Draw speed 5 µL/s 
Draw delay 500 ms 
Dispense speed 20 µL/s 
Dispense delay 0 ms 

Wash procedure 

Wash Speed 20 µL/s 
Waste speed 32 µL/s 
Needle wash BeforeInj 
Needle wash volume 50 µL 
Loop wash factor 1 

Sample temperature 10 °C 
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Parameter Value 

Sampler 

 
 

10.2.3 Injection Volume 
 

Parameter Method Value 

Injection Volume 
LC 5 µL 

FIA 20 µL 
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10.3 MS Settings and Tune Files 
 

Tune file File name 

LC tune 1 KIT2-LCtune1_1x1x.mstune 

LC tune 2 KIT2-LCtune2_1x1x.mstune 

FIA tune KIT3-FIA_1x11.mstune 
 

 Apply ALL values to positive AND negative polarity mode! 
 

tune file   LC tune 1 LC tune 2 FIA tune 

Option Parameter Value Value Value 

Scan 
parameters 

Scan type 
Scan range [m/z] 
Fragementation 

Resolution 
Polarity 

Microscans 
Lock masses 
AGC target 

Maximum injection time (IT) 

Full MS 
100.0 to 800.0 

None 
see page 110 

Positive/Negative 
1 

Off 
1e6 

see page 110 

Full MS 
100.0 to 800.0 

None 
see page 110 

Positive/Negative 
1 

Off 
1e6 

see page 110 

Full MS 
100.0 to 1 000.0 

None 
see page 110 

Positive/Negative 
1 

Off 
1e6 

see page 110 

HESI 
source 

Sheath gas flow rate 
Aux gas flow rate 

Sweep gas flow rate 
Spray voltage [kV] 
Spray current [µA] 
Capillary temp. [°C] 

S-lens RF level 
Aux gas heater temp [°C] 

60 
30 
1 

3.00 
--- 

300 
60 
550 

60 
30 
1 

3.00 
--- 

300 
90 
550 

15 
5 
1 

2.50 
--- 

300 
60 
120 

ESI probe position ring B ring B ring B 
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LC tune 1 LC tune 2 FIA tune 

   
 

 Shown Resolution and Maximum IT for Q Exactive™ Focus. 
 For other Q Exactive™ platforms refer to page 110. 
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LC1 Method for Q Exactive™, Q Exactive™ Focus and Q Exactive™ Plus 
KIT2-LC1_1x11.meth 

Parameter Value 

General Settings 
 

Q Exactive™ platform 

 

Tune Files 
 

Q Exactive™ platform 

 
 

 Shown Resolution and Maximum IT for Q Exactive™ Focus. 
 For other Q Exactive™ platforms refer to page 110. 
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LC Method for Q Exactive™ HF (KIT2-LC1_1311.meth) 

 Method parameter only for Q Exactive™ HF (combined Full MS + PRM). 
 

Parameter Value 

General Settings 
 

Q Exactive™ platform 

 
 

 add Full MS and PRM to one method 

 
 Full MS   PRM  

  
Inclusion List 

  PRM  
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Parameter Value 

Tune Files 
 

Q Exactive™ platform 

 
 

 
Using a Q Exactive™ HF, the data acquisition is fast enough to combine Full MS and 
PRM in one method without loss of analysis quality. 
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LC2 Method for Q Exactive™, Q Exactive™ Focus and Q Exactive™ Plus 
KIT2-LC2_1x12.meth 

Parameter Value 

General Settings 
 

Q Exactive™ platform 

 
Inclusion List 
Q Exactive™ platform  

Tune Files 
 

Q Exactive™ platform 

 
 

 Shown Resolution and Maximum IT for Q Exactive™ Focus. 
 For other Q Exactive™ platforms refer to page 110. 
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FIA_SST Method (all Q Exactive™ platforms) 
KIT3-SST_1x11.meth 

Parameter Value 

General Settings 
 

Q Exactive™ platform 

 

Tune Files 
 

Q Exactive™ platform 
 

 

 Shown Resolution and Maximum IT for Q Exactive™ Focus. 
 For other Q Exactive™ platforms refer to page 110. 
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FIA1 Method (all Q Exactive™ platforms) 
KIT3-FIA1_1x11.meth 

Parameter Value 

General Settings 
 

Q Exactive™ platform 

 

Tune Files 
 

Q Exactive™ platform 
 

 

 Shown Resolution and Maximum IT for Q Exactive™ Focus. 
 For other Q Exactive™ platforms refer to page 110. 
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FIA2 Method (all Q Exactive™ platforms) 
KIT3-FIA2_1x12.meth 

Parameter Value 

General Settings 
 

Q Exactive™ platform 

 

Tune Files 
 

Q Exactive™ platform 
 

 

 Shown Resolution and Maximum IT for Q Exactive™ Focus. 
 For other Q Exactive™ platforms refer to page 110. 
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MS resolution for Tune Files and Acquisition Methods 
 Q Exactive™ Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

LC tune 1 

70 000 70 000 70 000 
60 000 

LC tune 2 
FIA tune 120 000 

LC1 Method 
KIT2-LC1_1x11.meth 

70 000 70 000 70 000 60 000 

LC2 Method 
KIT2-LC2_1x12.meth 

35 000 35 000 35 000 30 000 

FIA_SST Method 
KIT3-SST_1x11.meth 

70 000 70 000 70 000 120 000 FIA1 Method 
KIT3-FIA1_1x11.meth 

FIA2 Method 
KIT3-FIA2_1x12.meth 

 
 

Maximum IT for Tune Files and Acquisition Methods 
 Q Exactive™ Focus Q Exactive™ Q Exactive™ Plus Q Exactive™ HF 

LC1, LC2 250 ms 250 ms 250 ms 150 ms 

FIA_SST, 
FIA1, FIA2 250 ms 250 ms 250 ms 250 ms 
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10.4 Abbreviations 
µL microliter 
bar bar 
Cal calibration standard 
Da Dalton 
ESI electrospray ionization 
ISTD internal standard 
LC-MS instrument combination of UHPLC pump and Q Exactive™ 
min minutes 
mL milliliter 
MS-PC PC that controls the Q Exactive™ instrument 
PRM parallel reaction monitoring 
QC quality control 
RT retention time 
sec seconds 
UHPLC ultra high performance liquid chromatography 
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Ordering and Technical Support 
 
Order AbsoluteIDQ® or Biocrates® Kits 
 

E-Mail: Phone: 
sales@biocrates.com +43 512 579 823 

 

Technical assistance 
 

E-Mail: Phone: 
support@biocrates.com Dr. Markus Langsdorf +43 676 848434 214 

 Dr. Manuel Kratzke +43 676 848434 105 
 Stephen Dearth, PhD +1 704 4216512   (North America) 

 

Web Site 

 http://www.biocrates.com 

 

Video Tutorials 

 
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk 

 

Frequently Asked Questions (FAQ) 
 

 
https://support.biocrates.com/tiki-index.php 

 

mailto:sales@biocrates.com
mailto:support@biocrates.com
http://www.biocrates.com/
https://www.youtube.com/playlist?list=PLGETE8vMYPlp_gSz4eMaSLG1QKB_mdFpk
https://support.biocrates.com/tiki-index.php
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